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Winlmage is a shareware product from an ASP member. You may copy and distribute Winlmage as long

as no fee is charged. You may charge a small fee to cover the diskette cost and shipping only. Wimimage
must be distributed in it's entirety, and include all of the files from the author.



A disk image is a file which is an exact and complete image of a floppy disk. The image contains
information on the disk format and structure, such as FAT, boot sector, directories, and all files.

By using Winlmage, you can create an exact copy of an original disk, including non-standard capacity and
format disks.

As an example, you can read a floppy disk and copy it as one image file to your hard disk. Later, without
using the original floppy disk, you can extract any file from the image - just as if you had copied the file
from the original floppy disk itself.

You can create exact copies of the original disk onto new floppy disks.

You can also create disk images with Winlmage. For example, if you want to put five files, taking 1.3 Mb,
on a 3"1/2 HD that has a normal capacity of 1.2Mb, you can create an empty 1.44 Mb image on the
floppy, inject the five files into it from the hard disk, and in one operation you have formatted the floppy
and written the image on it.

Unlike the DOS DiskCopy command, Winlmage can format and use very large-capacity and non-standard
disk formats. As an example, a 3"1/2 HD floppy can be formatted out to 1.72 Mb and a 5"1/4 HD can be
formatted out to 1.44 Mb.

Windows 3.1 and MSDOS. When reading a DMF, 1.68 or 1.72 MB floppy formatted by Winlmage under
MSDOS and Windows 3.1, the TSR utility FDREAD.EXE must be loaded at DOS level (first) if you wish to
read and write non-standard formats. FDREAD.EXE is a freeware program from Christoph H. Hochstatter.
If you will be using standard formats only, FDREAD is not needed.

Windows’95/98/Me and NT/2000/XP. FDREAD.EXE is not needed under Windows 95/98/Me and
Windows NT/2000/XP.

Once loaded, you can extract files from an image to any floppy, hard disk or network disk.

You can add files to an image.

The image can be copied onto a floppy (which must have the same format), or saved in a file.

An image file contains all the sectors of a floppy disk. If it's not full, you can truncate unused image parts,
making the image file smaller.

Winlmage can read images created by other disk copy ultilities.
Wimage (in FdFormat utility) from C.H. Hochstatter
CopyVit from Sébastien Chatard
DrDos 6
0S/2 2.x and 3.x
DCF (Disk Copy Fast) from Chang Ping Lee
DF (Disk Image File Utility) from Mark Vitt
Super-DiskCopy from Super Software
SabDu from S.A. Berman
Disk-RW from K. Hartnegg
DiskDupe from Micro System Design

and the internal Microsoft and Lotus image features and utilities along with the MFMT sample Windows

NT application that comes with the Windows NT SDK.






There are two versions of Winlmage : standard and professional.

Registering options are different:
Winlmage 6.10 Professional - price for NEW USERS of Winlmage is $60.

Winlmage 6.10 Standard - price for NEW USERS of Winlmage is $30.

Winlmage 6.10 Standard - price for registered users of any previous version of Winimage is FREE
Winlmage 6.10 Professional - price for registered users of any previous version or Winlmage 4.0/5.0 or
6.0 Standard is $30.

Winlmage 6.10 Professional - price for registered users of Winlmage 4.0/5.0 or 6.0 Professional is FREE.

Winlmage 6.10 Developer Edition - price for NEW USERS is $200.
Winlmage 6.10 Developer Edition - price for registered users of Winimage Professional is $150

Winlmage Professional adds all these feature to Winlmage standard:

- Self extractor with unlimited redistribution license.

- File Properties - allows modification of file dates within image.

- You can export the directory of the current image in text or HTML.

- Printing of the directory of the image

- Edit boot sector properties (i.e. load another boot sector file, edit text in the boot sector...)

- Supports the creation of large images of removable and hard disks under Windows NT and Windows 95.
Large images (> 2.88 MB) are not loaded in memory, read and write operations are done directly in image
files.

Winlmage Developer Edition contain Winlmage Professional, the Winlmage SDK and a licence to
distribute software made with Winlmage SDK and the Winlmage SDK DLL on 10 (ten) computers.

Note: the upgrade for registered users of Winlmage versions 1.0, 2.x, 3.0, 4.0, 5.0 or 6.0 standard to 6.10
standard is free. The upgrade from Winlmage 4.0, 5.0 or 6.0 professional to 6.10 professional is also free.

If you don't have a Winlmage Professional license, you can use the Professional version for 30 days (30
REAL days : if you start testing on July 1st and use it only on even numbered days, you can use it until
September 1st).

At that time, you'll be automatically switched to standard mode.



With Winlmage's self extractor, you can create a Win32 x86 .EXE file with one or several image files.

If you are a reqistered user of Winlmage professional, you can redistribute this executable without
restriction.

The file.exe you create can be used under Windows NT-x86/Windows 2000/Windows XP, Windows
95/98/Me and Windows 3.1 with Win32s 1.30c¢ installed.

How to create a self-extracting file:

- Create a .IMZ or a .\WLZ file with Winlmage

- Under the File menu, select Create Self-Extracting file...

- in the "Select source Image file" screen, click on "Select an image source file" and select the .IMZ, .WLZ
or .IMA

- in the second screen, select the .EXE file to create

To create a self-extracting file with one image, you can also open this image and Under the File menu,
select Create Self-Extracting file...Then create the EXE from the image in memory.

After selecting the source of the image file, choose the default command line options of self-extractor. The
self extracting executable accepts the following options:

A: Write to floppy A: (or B:)

IF : Format floppy when writing

IN:xx : When writing a floppy, select the number of sets (xx is number>1)
/X directory : Select file extraction to specified destination directory

/NI : Don't increment directory when file extraction is selected

IW:XXX : Writing image file xxx

/H: Hide dialog

/B : Stop reading command line (ignore options following)

1QF : In self extractor command line to hide "insert floppy disk" dialog

IT: Winlmage always issues a warning with a Yes/No dialog when the target disk is not
empty and files will be overwritten. Default = "/T+, don't warn: "/T-" option

N Verify writing. Default = "/V+", don't verify: "/V-" option

/l Ignore empty tracks when writing. Default = "/I+" , don't ignore= "/I-"
/0 Confirm Overwrite when extracting. Default = "/O-", do ask = "/O+"

These options can be embedded in the .EXE with SFXSETUP.EXE, or when running the .EXE
(the SFX runs the embedded option first, and EXE command line after).

If you specify the /B option at the end of a command line (when creating an SFX executable file),
command line options specified by the user, when starting the .EXE will be ignored.



The Winlmage SDK is a Win32 DLL, with C, Visual Basic and Delphi importation files.
With the Winlmage SDK, you can create a Win32 application that can read and write floppies, read and
write image files, extract files from images, inject files into images and other Basic Winlmage functionality.

The Winlmage SDK is an additional product, based on the Winlmage technology.
For download an evaluation version or for more information, visit the Web site

http://www.winimage.com/wima_sdk.htm .

The Winlmage Developer Edition contain Winlmage Professional and the Winlmage SDK.



SmartVersion is a new shareware from Gilles Vollant, the creator of Winlmage.

SmartVersion is a tool for storing multiple versions of your files inside SmartVersion Files (SVF files). You
may then send these SVF files to your end-users. Your end-users can use SmartVersion to extract the
version they desire from the SVF files and update their product. You may also customize exactly which
versions are delivered to your end-users.

SmartVersion uses intelligent compression and file comparison algorithms. Only the changes between the
different product versions are stored in the SVF files. This eliminates redundant data in your SVF files and
makes sure the patches you create for new versions of your products are as small as possible.

For some file's types (such as text file, HTML files, Word Processing files...), it takes a significant smaller
disk space than compressing each version individually.

SmartVersion, unlike other patching schemes, is not limited to working with software products, or
providing single version upgrades.

For more information, and for downloading SmartVersion, just visit the SmartVersion Web Page (
http://www.smartversion.com )

Real world usage example:
1) A Book writer

Let's say you're working on a book. How can SmartVersion help you?

As the author, you can use SmartVersion to store several versions of the file of your book. Let's assume
you work with an editor who reviews and modifies your work. Your editor has a slow connection to the
Internet, which complicates matters when you are emailing him files of your book.

The first time you send the book to your editor, you will send a SmartVersion file which contains only one
version of the book (an empty patch, which will be exactly the same size as a ZIP file of your book file).
The editor does take a lot of time to download the book, but with SmartVersion, this is the only time he will
suffer for the duration of the project.

So moving along, your editor makes some changes to the book, and adds a new version of the book with
his changes to the SmartVersion file (adds a new version to a patch). As he makes further changes, he
adds those to the SmartVersion file as well. When he wants to correspond with you to send you his best
copy, he makes a new SmartVersion file which contains just his changes (a minimal patch with a version
subset). In this way, your editor obtains a very small SmartVersion file that he has no trouble at all
sending back to you, even over his slow Internet connection.

Finally, when you receive the file, you open it with SmartVersion. SmartVersion asks you for the location
of file of the first version of this patch (specifying an existing version folder), and then lets you extract your
editors latest version with all his changes.

2) A Webmaster

A webmaster designs a web site. Sometimes, he experiments with several different styles on his site, and
wants to be able go back if the modifications are not satisfactory.

Each day, he adds the current version on the SmartVersion file for his web site. On days when he tries



several modifications, he saves several versions of the web site inside the SmartVersion file (adding new
versions to a patch). The website contains a lot of HTML files and images in the form of JPGs and GIFs,
all contained inside the SmartVersion file.

Before the webmaster discovered SmartVersion, he had created 10 ZIP files containing 10 different
versions of his website. But now, he just creates a single SmartVersion file with all these 10 versions. He
imports his exising ZIP files (adding new versions to a patch) into a new SmartVersion file (starting with
an empty patch). And he discovers that while the ZIP files together took up 10 MB, the SmartVersion file
just takes 2.5 MB of space, and neatly contains all his website versions!

When he is done with his site, our webmaster has a SmartVersion file with, say 40 versions. At any time,
he can extract one or several files from any of the versions (extracting versions from a patch). Let's say
he wants to keep an archive of the evolution of his web site...but he doesn't want to keep all the versions
of the site either...no problem! The webmaster selects the, say 10 versions he wants to keep, and then
creates a new SmartVersion file for safekeeping (building partial patches).



You can load an image into Winlmage by either reading a floppy, reading an image file, or creating an
empty image.

When an image is loaded, Winlmage shows the files and directories present. You can change directories
by double-clicking on the directory. You can return to the parent directory by double-clicking on the parent
or first entry ("..").

Winlmage can load an .ISO CD-ROM image file, in read only mode.

The image is loaded into memory. When there is no image loaded, some features are not available.

You can create a directory, delete or add files in the image from the toolbar or the Image menu option.

You can use drag-and-drop from the Windows File manager to Winlmage to inject data into an image, or
from Winlmage to another application to extract from it.

You can extract files in three ways: From the Image menu option or toolbar icon, by launching a file by
double-clicking on it, or by dragging it to another application.

Winlmage allows you to drag the image file from Winlmage to another application by placing the mouse
pointer onto the status bar or in the toolbar background. Press the left mouse button and keep it
depressed, slide the pointer onto another application (drag and drop client), and release the mouse
button. This original function allows you to add the image to a .ZIP or .ARJ file when using Nico Mak's
WinZip utility, or attach the image to an e-mail created with Microsoft™ MS-Mail, or Lotus™ Notes or
ccMail.

| suggest that you do not use the 820 KB or 1.72 MB formats, because Windows NT can not read them. |
suggest that you use the DMF or the 1.68 MB format instead.

You can start Winlmage with options in the command line:

'WINIMAGE [source [destination] [options]]'

'WINIMAGE file.ima' : Load the file file.ima

'WINIMAGE file.ima A:':  Load the file file.ima, write on A: and exit

'WINIMAGE A: file.ima':  Load from floppy A: and save file.ima

WINIMAGE /MAKESFX imagefilename.??z imagesfx.exe <command option>;  Create a self-extractor
file using a .wlz or .imz file, and with <command option> default option for the SFX file.

Option :

IF: Format when writing a floppy from the command line

IE: Do Extract (second parameter can be destination)

IX: Do Extract with sub-dir (second parameter can be destination)

Q: Always exit after command line operation

/H: Hide the main Winlmage window

INX : Never exit after command line operation

INXXX : Create a new image (where xxx is DMF1024, DMF2048, 144, 120...)
/TXxx: Transform image size (where xxx is DMF1024, DMF2048, 144, 120...)
/I Xxx : Inject file or directory xxx

INOASPI : Disable the ASPI device checking in start (this disable CDRom image creation

option under Windows 95/98)



DMF and 1.68 MB formats are the same physical format of 80 tracks and 21 sectors per track. The 1.68
MB format has 224 entries in the root directory, and a cluster size is 512 bytes. DMF format has only 16
entries in the root directory (you need create a subdirectory to copy more than 16 files), and the cluster
size is 1024 (DMF 1024) or 2048 bytes (DMF 2048). You can check the cluster size in the Image
Information...

Microsoft uses DMF 2048 for the floppy version of some of their newer software. Windows 95/98 and
Windows NT 3.5x read and write directly in DMF format. You will need FDREAD for this format under
MSDOS or Windows 3.1.

1.72 MB format uses 82 tracks and is not compatible with Windows NT. 1.68 MB and DMF are the same
physical format, and are compatible with Windows NT. | highly suggest you don't use 1.72 MB.

Some Microsoft DMF floppy disks contain information to make them write-protected under Windows 95/98
or Windows NT 3.5x. To write to these floppy disks, you will need to reformat them first to remove this.

The DMF 2048 format is often used for distribution floppies under Windows 95/98 and Windows NT.
Under Windows 95/98, unlike other operating systems, formatting for DMF uses the BIOS. This may
cause compatibility problem on some computers. If you experience such problems, | suggest you try the
following:

- If your system has a flash BIOS, upgrade the BIOS to the latest release. If you have an Intel
motherboard, you can find BIOS upgrades at ftp:/ftp.intel.com/pub/bios.

- Format the floppy to 1.44 MB before trying DMF.

- Try to get more conventional memory (ideally by having a near empty config.sys) .

- Try using both winimage.exe and winima16.exe under Windows 95/98. (Ignore the message from
winima16.exe that suggests not running using this O.S.) . Note : The latest 16 bits version of Winlmage is
Winlmage 3.0.

- download FDFormat (from http://www.winimage.com/othertl.htm ). Under DOS (or the Windows
95/98 command line without the graphical interface - this is accomplished by pressing F8 and selecting 6
when booting) try 'FDFORMAT A: F168'. As is true with Winlmage, FDFormat uses the BIOS. If FDFormat
cannot format a disk at 1.68 MB, WinIlmage will also be unable to.

Some problems with DMF formatting under Gateway 2000 computers can be solved by downloading a
BIOS update from the Intel FTP (ftp://ftp.intel.com/pub/bios) or their web site (http://www.intel.com).

Under Windows 95/98, the following options are available In the Options Settings, Disk tab:

- If Use new DMF format technology and Use new DMF technology for writing data are both selected,
Winlmage will use the new 3.0 DMF formatting code by default.

- If Use new DMF format technology and Use new DMF technology for writing data are both unselected,
Winlmage will use a slightly fixed version of the 2.5 DMF formatting code.

- If Use new DMF format technology is unselected, Winlmage uses the same code as version 2.20 to
format.

Some DMF related problems can be corrected by adjusting the disk gap. To change this setting, you
must modify the registry. Be very careful! The key value to modify is HKEY_CURRENT_USER\Software\
Winlmage\iGapDmf. A value of "0" specifies the standard DMF GAP. A Winlmage user needs "17" for a
2.88 driver.

Please report any problems solved by modifying the GAP.



The professional version of Winlmage can create images of hard disks and removable (SyQuest, Zip...)
drives.

To create an image, select your disk on Disk menu, and select Disk Read disk. Winlmage will ask you the
name of the image to create. It’ll read your entire disk, and open the image.

When Winlmage opens a large image (hard disk or removable), it doesn’t load the image in memory. All
modifications (Inject, etc...) will be immediately committed in the image.

For writing the image on the disk, open the image in Winlmage, select the disk in Disk Menu, and select
Disk Write disk.

Winlmage is a Windows application. You will need Windows to run Winlmage to restore the image.

If the free space in the partition is defragged and at the end of the partition, and if you select "Ignore
empty track in reading" in the Disk tab in Option settings, the image size will be reduced and will not
contain free clusters

If you have a FAT32 partition (created by Windows 95 OEMSR2, Windows 98 or Windows 2000), you
cannot read this partition under Windows NT 4.0. With File Connect Fat32 drive..., you can open your
partition under Windows NT 4.0 (you need Administrative rights).



Winlmage can open and build 1ISO-9660 image files directly from a CD-Rom.

Winlmage can read and open ISO-9660 images created with CD-writer utilities such as Easy-CD Creator
or CDRWin. You can also burn with these software packages ISO image build by Winlmage.

Unlike FAT, FAT32 or NTFS file systems, the ISO-9660 file system, used in CD-Rom and CD-Rom image
file is not designed to allow add, suppress or rename file.

Winlmage cannot modify an ISO image. You can only open the image, display list of files in the image and
extract them.

There is only one exception, introduced in Winlmage 6.0: Winlmage can replace a file by a new version of
the same file (same filename, same length).



Starting with Winlmage 6.0, you can encode .WLZ and .IMZ files with a password.

When you save a .WLZ or .IMZ file, you can enter a password. Winlmage will encrypt the image file with
this password. This password will be required for opening these files later.

Winlmage use MD5 algorithm ( http://userpages.umbc.edu/~mabzug1/cs/md5/md5.html ) to build a

128 bits keys from password, and then the new Rijndael encryption algorithm
(http://www.esat.kuleuven.ac.be/~rijmen/rijndael/index.html ).

You can create Self-Extracting EXE file with encrypted file. Of course, this executable will prompt the user
for a password.

Before sending encrypted file on the Internet, check that your country laws allow 128 bits encrypted files
transmission.



New

Creates a empty new image. You must select a format (for example: 1.44 Mb).

Open
Opens an image file.
Connect Fat32 drive

This option exists only under Windows NT if you have a hard disk with a Fat32 partition. You'll open a
Fat32 partition in Winlmage.

Close image

Closes the current image.

Save

Saves the current image.

Save as

Saves the current image with a new name.

File can now be saved with a password. In this case, the user needs to enter the password for opening
the file.

Save as Text/Html

This option exists only in the professional version. You can write a text or Html file with the directory of

current image.

Print
Configure printer

These options exist only in the professional version. They allow you to print the directory of the current
image.
Batch Assistant

Batch Assistant wizard

Opens the Batch assistant dialog box. The wizard option offers an alternative interface to select options,
step by step.



Create Self-Extracting file
This option allows you to create a self-extracting executable which contains one or several images. If you
are a registered user of Winlmage professional, you can redistribute this executable without restrictions.

Exit

Quits Winlmage.



Create directory

Creates a directory in the current image.

Select

Selects files in the current image.

Inject

Injects files into the current image.

Inject a directory

Injects a complete directory or subdirectory, into the current image.

Extract

Extracts files from the current image.

If no file is selected, Winlmage extracts all files from the image by default. Otherwise it extracts only
selected files.

Depending on the Confirmation option, you will have to specify the extraction path. (A dialogue box with
some Preference fields is shown).

Delete file

Deletes files from the current image, after asking for confirmation.

If there is no file selected, Winlmage deletes all the files from the image by default, otherwise it deletes
only the selected files.

File properties

Change the file date (only in professional mode), attributes and name. The file can only be renamed when
only one file is selected

Change Label

Changes the volume label of the current image.



Boot sector properties

You need the professional version to edit boot sector properties. With this option, you can change the
OEM string of a disk, the serial number, or choose a Windows NT, MS-Dos 6.22, Windows 95/98 or
Winlmage (Reset button) boot sector. On a Winlmage boot sector, you can enter the text displayed when
booting the floppy.

Change size

Changes the size of the current image.

The new size must be greater than the total size of the files in the image.

For example: a 1.44 MB image can be changed into a 360 KB image only if it has less than 360 KB of
files.

Defrag current image

Defragments the current image files.

Image information

Shows information about the current image, and allows editing the image's comment.



Use drive A: or B:
Selects drive A: or B: to read and write floppies.

On a computer with two drives, this command lets you choose the physical drive you want to use for
reading or writing disks.
In the professional version, you will also see the disk (hard disk and removable) drive, for disk image

operation.

Format disk

Formats a blank floppy.

Create CDRom Iso image

Creates and opens an ISO image file from a CD-ROM.
Read disk

Reads a floppy and stores the image in memory.
Compare disk

Compares the current image with a floppy.

Write disk

Writes the current image to a floppy.

Format and write disk

Formats a floppy and writes the current image onto it.



Sort by Name
Sort by Type
Sort by Size

Sort by Date

These options are used for displaying the files present in the image.

Classic Listbox
Large Icon
Small Icon

List

Details

Theses options change the presentation of the directory in Winlmage's main Windows. These are the
same options as in the Windows explorer.

Font

Changes the current font (used for displaying the files present in the image).
Setting

All options appear in one tabbed dialog box.

Disk Tabs

Seltings H |

Disk |Image| Estract | File | Matification | General |

[~ Ignaore empty tracks when reading

[ Ignare empty tracks when writing
W erify writing

[T Usze only standard format

¥ Search Fat32 partition when starting 'Winlmage

] I Annuler Aide




- Ignore empty track when reading : if this option is checked, when reading or comparing a floppy which
isn't full, Winlmage will ignore unused tracks.

- Ignore empty track when writing : if this option is checked, when writing an image to a floppy which isn't
full, Winlmage will ignore unused tracks.

- Veerify writing : if this option is checked, Winlmage verifies after writing to a floppy. This takes a bit more
time, but you will be sure the new disk is readable.

- Use only standard format : if this option is checked, Winlmage creates only standard floppies. Under
MSDOS and Windows 3.1 FDREAD will then not be needed.

Under Windows NT, you'll have :

- Search Fat32 partition when starting Winlmage : Asks Winlmage to search a Fat32 partition in your hard
disk. If it's found, you'll be able to connect on this partition.

Under Windows 95/98, you'll have these options :

- Use IOCTL : Tells Winlmage to use 32 bit IOCTL operations (except for formatting DMF, which is not
affected by this checkbox). The default status is - checked.

- Use new DMF format technology : If this is not checked, Winlmage formats DMF in the same way as in
version 2.20. If it's checked, it uses new code.

- Quick format in 1.44 MB before DMF : If this is not checked, Winlmage does a quick format in 1.44 MB
before formatting in DMF. It seems to be difficult to format a blank floppy in DMF without formatting first as

1.44 MB.
For more info on DMF, see the DMF section.

Image tabs

Seltings H |

Drizk, Image |E:-:tran::t| File I Nn:ntifin::atin:nnl Generall

¥ Select floppy for image

[T Truncate unused image part

¥ Use incremented open/zave wizard

V¥ Weiify disk contents befare writing image ta disk

Compression: J

r-:“la:-:i;'nurﬁ [sluéuwelst] [EII]

k. I Annuler Aide




- Select floppy for image : if this option is checked, Winlmage selects a floppy type appropriate for the
image in memory. (If you load a 360Ko image, Winlmage selects a 5"1/2 floppy format).

- Truncate unused image part : if this option is checked, Winlmage reduces the size of the image when
writing an image file which isn't full.

- Use incremented open/save wizard : if this option is checked, Winlmage increments the filename by 1.
As example: after opening (or saving) "DISKO1.IMA", Winlmage proposes "DISK02.IMA" or the next file
name.

- Veerify disk content before writing : if this option is checked, Winlmage asks for confirmation before
writing to a disk which already contains data.

- Compression : select the level of compression when saving compressed image file.

Extract tabs

Settings H |
Dizk I Image Extract |File I Nu:utifiu:atiu:unl Generall

Path uzed far file ;

Iu:: Stempl Browse. .. |

" |gnore subdirectories

¢ Eutract with pathname

" Estract all filez into the zame directorny

¥ Confirm extraction from menu or toolbar
¥ Confirm extraction using drag and drop from Winlmage
¥ Confirm extraction for launch

¥ Confirm ovenwite when extracting

k. I Annuler Aide

- Path : Here you specify where to get the files to form the image.

The following options are for extracting subdirectories.

- Ignore subdirectories : Winlmage won't extract the subdirectory(s) selected.

- Extract all in the same directory : Winlmage extracts all the files in a subdirectory of the image in the
Path location.

- Extract with pathname : Winlmage extracts files from a subdirectory of the image to a subdirectory of the
Path location.

The first three checkboxes control the display of the confirmation dialog box when extracting files.

- Confirm overwriting when extracting: if this option is checked, when extracting risks overwriting a file,
Winlmage will ask for confirmation before proceeding.

File tabs



Settings H |

B I Imagel Eutract File |N|:utifi|:ati|:|n| Generall

¥ ‘Confirm injection from menu or toolbar

¥ Canfirm injection from drag and drop to Winlmage

W Corfirmn injection when replacing a file in an image

¥ Canfirm file deletion

k. I Annuler Aide

The first two options allow you to enable/disable the use of a dialog box when injecting files. The third

asks for confirmation when replacing files.
- Confirm file deletion : this option controls the display of the confirmation dialog box when deleting files

on image.

Notification tabs

Settings EH |

Dizk I Imagel E:-:trau:tl File Motification | Generall

Floppy read completed
Wiriting a floppy

Flappy write completed
Batch azzistant completed

— Sound
i~ Mo zound
=) Simple been

= Flay a zourd file Iu::"-.wind-:uws'xdring.wav

Browse. .. | Test |

=1 Show & message boy

0k | Aner | siee |




Select sound and message
With this option, you can ask Winlmage to play a sound, beep, play a .WAV or .MID file. Under Windows
95/98 or NT, .AVI files can also be played.

General tabs

Settings H |

Dizgk I Imagel E:-:trau:tl Fil= I Matification General |

Browse... |

Default viewer:

Language: I Englizh j

¥ Usze new contal for browsing directany
¥ Dirag and Dirop within explorer
¥ Display icon in tazkbar when working

¥ automaticaly show Winlmage when uzer input needed
|'Elptin:|ns for reqistered users

[ Display =plash screen when loading Winlmage

k. I Annuler Aide

- Default viewer : defines the viewer application launched when double-clicking on a file without
association.

- Use new control for browsing directory : select the control used for searching a directory.

- Drag and Drop within explorer : allows user to extract files by dragging from Winlmage to the explorer
(and the desktop)

- Display icon in taskbar when working : when Winlmage works on floppy or in batch assistant mode, it
displays an icon in Win95/NT4 taskbar. It blinks when user input is needed.

- Automatically show Winlmage when user input is needed : When user input is needed (change floppy,
error, etc...), Winlmage pops up automatically. This allows you to minimize Winlmage during long
operations (floppy...), and be sure not to forget it!

- Options for registered user : see Registering.




By using the batch assistant, you can chain operations on several images.
There are two different interfaces of the Batch assistant :
- With File Batch Assistant, you'll have all settings in one dialog box
- With File Batch Assistant wizard, you'll have several dialogs boxes, step by step.

When selected, this dialogue box appears.

Batch assistant E |
— Source — Destination
' Set of floppies [ Set of floppies
¢ Set of images files [ Set of image files
" Directaony injecting ¥ File extraction
— Set of image files — Set of floppies
DISKIMA Open list... | I'I_ MNurnber af zet [™ Formatting
DISKZ kA -
OISk 4 [ka
DISkS A Remove | — Set of image files
[ Change Farmat: I Browse... |
1 4k E
Eharae... | List... |
— File extraction
Demo set disk. I'31"*tEl""II"‘":"Sk'I wl
¥ Increment directonies
Cancel Help | Wizard... | Open... | Save... | Clear |

When Winlmage executes a batch, it repeats the sequence of :
creating an image in memory reading a source, and saving this image for saving to a destination. When
the source has no image, the batch is complete.

The following sources can be selected.
- Set of floppies : Winlmage will read floppies. You need to tell Winimage how many floppies you want
to be read.
- Set of images files : Winlmage will load images. You can open a list file (.WIL), a set of compressed
image (\WLZ, a ZIPfile with a .WIL and several .IMA) or add some images manually.
- Directory injecting : Winlmage will inject directories into an image. If the directory name contains a
number, it can increment the directory name, and make an image for each directory. If a directory is
bigger than an image, Winlmage will make several images.

The following destinations can be selected.
- Set of floppies : Winlmage will write to floppies. You tell Winlmage if you want it to format also.
- Set of image files : Winlmage will write images. You specify the filename of the first, and Winlmage
increments the subsequent filenames and you can optionally make a list file (\WIL) with a comment. Or
you can create a set of compressed images (.WLZ): one file will contain the list and all images.



- file extraction : Winlmage will extract files from an image to directories that you specify. It can also
increment the directory name.

In this example, Winlmage is configured to extract the file images DISK1.IMA through to DISK5.IMA, to
directories c:\temp\disk1 through c:\temp\disk5.

Before running the batch, you can save your configuration in a batch configuration file (.BWZ). This file
can be opened later to run batch with same parameters. Like .WIL, BWZ files are text readable files.



September 2002 : Version 6.10

- Compatibility with some CDRom images file (some version of Easy CD Creator...) is added

- Displaying very large directory (>500 files by example) is faster again. Useful for ISO or hard disk image
- Several minor bug fixes.

July 2001 : Version 6.00

- File can now be saved with a password. Winlmage use MD5 algorithm to build a 128 bits key, and
Rijndael encryption algorithm

- Winlmage can now be installed with a self-install setup executable

- File in 1SO CDRom image can be replaced by a file with the exact SAME SIZE and FILENAME. Note:
Because the .ISO file format is not designed to be altered, this is the only modification possible in ISO
image.

- The /IMAKESFX option is fixed (for create SFX .EXE in command line)

- New Self Extractor command line options

- Winlmage can now open/read/write Linux EXT2fs image, but don't understand file system (like
Macintosh floppies)

- Displaying very large directory (>500 files by example) is faster. Useful for ISO image

- Better support of DBCS resource file under Windows 2000

- When starting under Windows 2000 (or Windows NT4) with old and buggy ASPI layer, previous
Winlmage sometimes crashes. This is fixed.

April 1999 : Version 5.00

- File Properties allow the modification of flename and attributes of files within

the image.

- Better international support: Winlmage and self-extracting files can now be

translated into far-east languages (like Japanese).

- The CD-ROM ISO image creation option is now compatible with Windows 95/98.

- Inject and Extract progress dialog boxes contain a "Stop" button.

- The delete option can now delete non-empty subdirectories in an image (and do recursive delete).

- The opening of Fat32 is faster and has better support of large FAT32 partitions.

- The documentation now states Winlmage's Year 2000 compatibility (but previous versions were already
fully Y2K compliant).

And only in professional mode:

- File Properties allow the modification of file dates within the image.

- Self extractor file creation is now integrated into the Winlmage interface, and SFX executable are now
translated (in Winlmage 4.0, SFX file were only in English).

- More options in the self extractor

And the Winlmage Developer Edition, with Winlmage SDK and Winlmage professional is released

July 1997 : Version 4.00

- Command line option

- There is now a true wizard (several screens with Next and Previous !) as an alternative to the Batch
assistant dialog box.

- Under Windows NT, Winlmage can directly open a Fat32 partition on the disk (useful because Windows
NT 4.0 cannot directly read a Fat32 partition)

- Batch options can be saved in a .BWZ file




- option Display icon in taskbar when working.

- option Automatically show Winlmage when user input is needed.
- Toolbar buttons are modernized

- There is now only a Win32 version of Winlmage. Users of Windows 3.1 need install Win32s 1.30 to use
Winimage.

And, in the professional version :

- Self extractor with unlimited redistribution license

- You can export the directory of the current image in text or HTML.

- Printing of the directory of the image

- Edit boot sector properties (ie load another boot sector file, edit text in the boot sector...)

- Supports the creation of large images of removable and hard disks under Windows NT and Windows 95.
Large images (> 2.88 MB) are not loaded in memory, read and write operations are done directly in image
files

September 1996 : Version 3.00

- Added ZIP compatible compressed image file (.IMZ and .WLZ)

- Added a comment feature for compressed image files.

- Added drag and drop from Winlmage to the Windows 95/Windows NT 4.0 Explorer for file extraction

- When you drag a file into Winlmage without opening an image, Winlmage will automatically display the
"New" dialog box

- Winlmage can copy Maclintosh 1.44 MB floppies, but will not view the files in the image.

- Under Wintows NT, Winlmage can build CD-ROM ISO compatible images.

April 1996 : Version 2.50

- Support of the new ListView control and tabbed dialog boxes for settings under Windows NT 3.5x,
Windows 95 and Win32s 1.30

- Open an ISO CD-ROM image in read-only.

- Fixed bug while formatting DMF under Windows 95

September 1995 : Version 2.20

- Support for 32bit Win32s for the Intel version under Windows 3.1x.
- Format a blank disk without creating a new image.
- Fixed bug while formatting and writing DMF under Windows 95 and Windows NT 3.5x

June 1995: Version 2.10

- Windows 95 compatibility
- Support of Microsoft DMF format - 1.68 Mb floppy

January 1994: Version 2.00

- Added the Batch assistant.

- Show disk directory when reading.

- Winlmage can be iconised when reading or writing a floppy.

- New toolbar.

- Image information.

- Title bar.

- Sound noatification.

- Support for .DLL resources (for languages other than French or English).

September 1993: Version 1.11



- Support of directory drag from Windows File Manager.
September 1993: Version 1.10

Main differences:

- Windows NT version: built for the released version of NT, drag and drop server runs correctly.

- Functions for deleting files in an image, changing format and defragmenting.

- You can drag an image file from Winlmage to another application.

- Better usability: new menu, news option and confirmation dialog boxes, "Always on top" in system
menu, last four files in File menu. Help on toolbar via button.

- Incremented filenames.

- Better support of comparing and option saving.

May 1993 : Version 1.0
First version

A Winlmage SDK with functions to create an image, read/write it on file or floppy, inject/extract, etc., is
planned. Please send me email if you think this project could be useful to you.

There is now only a 32 bit version of Winlmage. Users of Windows 3.1 need to install Win32s 1.30
(downloadable at ftp://ftp.microsoft.com/softlib/MSLFILES/PW1118.EXE).

Background reading or writing disks using WINIMAGE.EXE will ABSOLUTELY NOT degrade application
performance under Windows NT or Windows 95 (with the exception of operations with the DMF format
under Windows 95). Note: in version 2.x, WINIMAGE.EXE was the 16 bit version and WINIMANT.EXE
was the 32 bit. Now, WINIMAGE.EXE is the 32 bit version.

There are Intel 80x86 and DEC Alpha versions of Winlmage NT. I'm interested in receiving feedback from
users of the RISC version.

There are English, French, German, ltalian, Portuguese, Brazilian, Dutch and Spanish versions of
Winlmage. If you would like to provide translations of Winlmage or the documentation in another
language, please contact me.

WINIMAGE.EXE uses WIM16T95.DLL and WIM32T95.DLL under Windows 95, and WIM1632S.DLL
under Windows 3.1x + Win32s 1.30. The file HLR20A16.EXE, distributed in some old beta releases, is no
longer used.

If you find Winlmage useful, give it to your friends and upload it to your BBS.



Building user-friendly software requires the help of a lot of people.

The DOS utilities FdFormat and Wimage from Christoph H. Hochstétter gave me some great ideas.
Without his source code, | couldn't format large format floppies.

By creating new icons and bitmaps, Francois Liger gave Winlmage a better look. By giving me pieces of
code, Francgois saved a lot of my time. Francois also wrote the setup code for the installation of this

By correcting the French documentation, Monique Vollant improved its syntax. Frangois Liger, Joél
Demay, Michael Segall, Peter Sohn, Matthew Gardiner, Ray Kaliss and Francis Weil assisted in the same
way with the English documentation. Kent Cedola, Mickey Lane and Mary Geddry built the Dec Alpha and
Mips R4000 Windows NT version.

Some ideas and tests have been coming from beta-testers. My thanks to David Chemla, Thierry Halin,
Ralph Burri, Sylvain Surcin, Amando Senra, Augustin Garcia, Badara Dafe and particularly Fabrice
Letard, Joél Demay, Michel Nedelec and Luc Coiffier.

Patrick Rafamantanantsoa, Bernard Maudry, Nico Mak, Serge Delbono and Michael Segall suggested
additional ideas for Winlmage.

I'm using the ZLib library (http://quest.jpl.nasa.gov/zlib/) written by Jean-loup Gailly and Mark Adler, for
compression support. | want to thank them a lot!



You can find the latest version of Winlmage :
- On the Winlmage web site, http://www.winimage.com and http://www.winimage.com/download.htm

You will find these files: (xx is the version number, for example, WINIMAG1.ZIP is a ZIP for version 6.10):

- WINIMAXxx.EXE: English help and executable files for Windows 95/98/Me/NT/Win2000/WinXP Intel, as a
self-install setup.

- WINIMAXxx.ZIP: English help and executable files for Windows 95/98/Me/NT/Win2000/WinXP Intel and
Windows 3.1 + Win32s 1.30 (win32)

- WIMA1630.ZIP: English help and executable files for Windows 3.1 (Win16). The 3.00 is definitely the
last Win16 version

- WIMAXPxx.ZIP: English help and executable files for Windows NT Dec Alpha

- WIMAMPxx.ZIP: English help and executable files for Windows NT Mips R4000

- WIMAPPxx.ZIP: English help and executable files for Windows NT PowerPC

- WIMAFRxx.ZIP: French help and resource files.

- WIMADEXxx.ZIP: German help and resource files.

- WIMAESxx.ZIP: Spain help and resource files.

- WIMAITxx.ZIP: Italian help and resource files.

- WIMAPTxx.ZIP: Portuguese help and resource files.
- WIMABRxx.ZIP: Brazilian help and resource files.

For example, a French user of Winlmage 6.10 under Windows XP will download WINIMAG61.ZIP or
WINIMAG1.EXE and WIMAFR61.ZIP and unzip them in the same directory.



Winlmage is a shareware product, you may copy, distribute, and try it, but if you use it after the evaluation
period, you must register. When you register you will receive a license, registration code, and the latest
release of Winlmage.

When you register Winlmage, you will receive a unique registration number. You should install that
number into Winlmage by selecting Registering in the Option menu, and enter the code when prompted.

Once registered, Winlmage will then allow you to hide the first screen in the Preference (Option menu).

If possible, check the web page http://www.winimage.com/order.htm Internet page before registering.
You'll have up-to-date registering information (foreign reseller...).

This page contains also link to internet secure server with credit card payment. This is the fastest and
easiest way to order Winlmage !

The price of Winlmage standard is $30.00 (US) or 27.50 Euro.

The price for an upgrade from Winlmage standard (or a version of Winlmage previous 4.0) to Winlmage
professional is $30.00 (US) or 27.50 Euro. I'll check if you are in my registered user database when you
order upgrade.

The price for Winlmage professional, full version is $60.00 (US) or 55.00 Euro.

The price of Winlmage Developer Edition, with Winlmage Professional and Winlmage SDK is $200.00
(US).

The price for an upgrade from Winlmage professional to Winlmage Developer Edition is $150.00 (US). I'll
check if you are in my registered user database when you order upgrade.

Of course, before accepting an upgrade, I'll check on my registered user database. If you can, | suggest
you contact me by email before buying the upgrade.

Contact me for site licence pricing. This is a very advantageous option !!
You can send check in Euro or French francs (french bank) or US dollars to (USA bank) to:

Gilles Vollant

4, rue de Morsang
91600 Savigny sur Orge
France

Fax : (33) (1) 69 05 85 54
Fax : (33) (1) 64 99 94 55 (backup number only)

E-mail : info@winimage.com
If possible, send an email when you send a letter or a fax for ordering.
If you send Eurocheque, be sure to write the amount in French francs.

If you can, | suggest you send me an email when you register by any method.



Credit Card Ordering:

You can order by credit card through Yaskifo and Digibuy, credit card order service, by fax or phone (and
of course by Web, from http://www.winimage.com/order.htm). The Web site contains also other ordering
services.

This software is produced by a member of the Association of Shareware Professionals (ASP). ASP wants
to make sure that the shareware principle works for you. If you are unable to resolve a shareware-related
problem with an ASP member by contacting the member directly, ASP may be able to help. The ASP
Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide
technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road,
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe
Mail to ASP Ombudsman 70007,3536.

Japanese customers may contact P&A Shareware Co. You can visit web page at http://www.panda.co.jp
and http://www.pandasw.com. Winlmage page is http://www.panda.co.jp/winimage/index.html .

P. & A. Inc.

No.3 Hoko Bldg. 6F

2-29-13 Akebono, Tachikawa
Tokyo 190-0012

Japan

Tel: (042) 525-9501
Fax: (042) 525-9502

NiftyServe: GO SPANDA
Nifty Email: PAF02461

Internet: http://www.panda.co.jp
Email: info@panda.co.jp
Email: sales@panda.co.jp

Australian user can contact:

Advanced Computer Products

85 McArthur Ave.(Cnr.Biggs St)
St.Albans,Victoria,Australia,3021
Phone: (61) 03 9364-1886

Fax: (61) 03 9367-3639

Email: sales@acproducts.com.au

Web page: http://www.acproducts.com.au

Korean user must contact:
SoftBuy / The CMI company
#3001, 30th Floor

Korea World Trade Center
Samsung-dong 159,
Gangnam-gu

Seoul

Korea



Phone: (02) 511-3085
Fax: (02) 511-3086

Web page: http://www.softbuy.co.kr






